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ABOUT THIS GUIDE 

The instructions and descriptions contained in this document were accurate at the time of publishing; 
however, succeeding products and documents are subject to change without notice.  Therefore, 
Window Book, Inc. assumes no liability for damages incurred directly or indirectly from errors, 
omissions, or discrepancies between the product and this document.   
 
Go to www.windowbook.com to download the most current version of this document.   
 
This document is formatted for 2-sided printing. 
 
Advanced Workflow Automation Manager™, AWAM™, DAT-MAIL™, PostalWeb Desktop Dashboard™, 
and Window Book Automated Scheduler™ are trademarks of Window Book, Inc. 
The following are trademarks (indicated by ™) or registered trademarks (indicated by ®) are owned by 
the United States Postal Service:  USPS® and PostalOne!®. 
Mail.dat® is a registered trademark of the International Digital Enterprise Alliance, Inc. (IDEAlliance). 
Windows® is a registered trademark of Microsoft Corporation in the United States and/or other 
countries. 
All other product names are trademarks, registered trademarks, or service marks of their respective 
owners. 
 
Copyright © 2019 Window Book, Inc.  All rights reserved.  All intellectual property rights remain the 
property of Window Book, Inc.  No part of this publication may be reproduced, distributed, modified, 
displayed, transmitted, stored in a retrieval system, or translated into any human or computer language, 
in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, 
without the prior written permission of the copyright owner, Window Book, Inc., 300 Franklin Street, 
Cambridge, MA 02139. 

CONTACT INFORMATION 

  WINDOW BOOK, INC. 
 300 Franklin Street 
 Cambridge, MA  02139 
 
  Corporate: 617-395-4500 
 Client Services: 800-524-0380 
  sales@windowbook.com 
 Support: 800-477-3602 
  techsupport@windowbook.com 
 Fax: 617-395-5900 
 On the Web: www.windowbook.com 

http://www.windowbook.com/
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mailto:techsupport@windowbook.com
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REVISION HISTORY 

This section contains a list of any significant changes that were made from the previously published 
version of this Guide, including a brief description of the change, the type of change made (i.e. Revision, 
New, or Deletion), a link to the location in the Guide where the change occurred, and any pertinent 
details relating to the change. 
 

CHANGE TYPE LOCATION IN GUIDE DETAIL 

Updated  Revision Cover page 
Updated cover page to coincide 
with the most current Window 
Book document style guide. 

Updated document Revision 
ABOUT THIS GUIDE 
and page footers 
throughout 

Updated copyright information. 

Updated document Revision Throughout Guide 
Replaced obsolete links to the old 
User Guides web page with links to 
Window Book’s Support Portal. 

Updated document Revision Throughout Guide Updated images where necessary. 

Updated section Revision 
Performance Related 
Settings, General Tab 

Added information about the 
options that allow multiple users to 
run the AWAM Control Center 
simultaneously. 

Updated section Revision 
Performance Related 
Settings, Notifications 
Tab 

Added information about the 
‘Notify on Server Failure’ option 
and the notification TEST buttons. 

Added section New 
DAT-MAIL ‘SECURITY’ 
USERS 

Added instructions for using AWAM 
with DAT-MAIL’s Security feature 
enabled. 
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BEFORE YOU BEGIN 

SYMBOLS YOU SHOULD KNOW 

The following symbols appear throughout this document: 
 

 Where displayed, this Information icon denotes important information regarding the subject 
matter at hand.  The information is intended to provide helpful hints, references to other 
locations in the document to help further understanding about the current subject-matter, 
and/or include special requirements pertaining to specific subject-matter.  It is important that 
the information provided be read and thoroughly understood before proceeding. 

 

 Where displayed, this Attention icon is intended to make the reader take special notice as the 
information provided is critical in nature to the subject matter at hand.  It is not intended to 
lessen the importance of the information provided with the Information icon noted above; but 
to bring additional attention in situations of extreme necessity. 

 

 Where displayed, this Troubleshooting icon denotes helpful hints and tips for the subject matter 
at hand.  The information in the troubleshooting tip is intended to provide helpful hints and 
resolutions for some of the more common issues that can occur during operation. 
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PURPOSE 

The purpose of this document is to provide activation, registration, and setup instructions for the 
Advanced Workflow Automation Manager or AWAM™, along with instructions for updating the 
software. 
 
Instructions for using AWAM are provided in the “AWAM User Guide” which is available on the User 
Guides web page within the Support Portal of Window Book’s web site.  Registration and/or login is 
required. 

INTRODUCTION 

AWAM is a powerful automated processing tool that uses profiles created by the Mailer to:  1) Import 
Mail.dat® files into DAT-MAIL, while performing a large variety of automated tasks on each file before 
and after the import occurs; and 2) Merge and/or apply automated updates or changes to files that are 
already in DAT-MAIL™ (i.e. post-import).   
 
While all profiles are created within AWAM™, they are applied using different utilities.  Import profiles 
are used by AWAM and the AWAM File Manager.  Merge and Post Process profiles are used by the 
AWAM Processing utilities available from within DAT-MAIL. 
 
Functioning as a true Windows® service, AWAM is intended to run on a server, but can also be run on a 
computer operating in a stand-alone or single installation environment.  In a server with workstation(s) 
environment, the available functionality differs between the server and workstation; both of which are 
documented in this Guide. 
 
AWAM can process up to 20 Mail.dat files simultaneously for much faster throughput (depending on the 
number of CPUs and memory available on the server; as well as, the size of the Mail.dat files being 
processed).  AWAM activity and profiles are managed via the AWAM Control Center, which is accessible 
from both the server and any workstations where DAT-MAIL and AWAM are installed.  Full control of 
the AWAM service is only available on the server installation of AWAM (i.e. install, uninstall, start, and 
stop); however, users are able to pause/resume and restart the service from a workstation installation, 
if necessary. 
 
AWAM also includes a separate utility to be used on workstations called the AWAM File Manager (File 
Manager).  The File Manager works specifically with Import profiles and provides the ability for a user to 
manually select and stage the Mail.dat files to be imported into DAT-MAIL, or use the AWAM Rules 
Manager to automatically do so by applying user-defined rules to each file.  For more information about 
the AWAM File Manager, refer to the “AWAM File Manager Installation & User Guide, which is available 
on the User Guides web page within the Support Portal of Window Book’s web site.  Registration and/or 
login is required. 
 
The AWAM Processing utilities that are used for merging files and/or applying post-import 
updates/changes are available for use from within DAT-MAIL; therefore, any computer where DAT-MAIL 

https://windowbook.na2.teamsupport.com/login/user
https://windowbook.na2.teamsupport.com/login/user
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is installed with AWAM can use these utilities (i.e. server, stand-alone/single-installation computer, and 
workstations). 

REQUIREMENTS 

The requirements to be able to activate and register AWAM™ as documented in this Guide are as 
follows: 

• DAT-MAIL™ software version 20.19.03.13 or newer must be installed first on the server and then 
any workstation(s) (if applicable) before activating and registering AWAM; 

• The activation of AWAM requires an AWAM registration key obtained from Window Book; 

• AWAM must have its own login account with the appropriate rights (created/implemented when 
AWAM is initially activated and configured).  Refer to the Installing the Service section in this 
Guide for more information); 

 Additional requirements exist for using AWAM.  Those requirements are documented in the 
“AWAM User Guide”, which is available on the User Guides web page within the Support Portal 
of Window Book’s web site.  Registration and/or login is required. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://windowbook.na2.teamsupport.com/login/user
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GETTING STARTED 

The activation of AWAM occurs within DAT-MAIL on the server (or computer in a stand-alone 
environment).  Once activated, AWAM must be registered using an AWAM-specific registration code 
obtained from Window Book.  To obtain the necessary registration code, contact your local Window 
Book Client Services representative (refer to the Contact Information section in this Guide for more 
information). 
 
Once AWAM is activated and registered, the Windows service must be installed before AWAM can be 
used.  In addition, some basic performance settings should be adjusted to best fit the Client’s operating 
environment. 
 

 AWAM cannot be activated, registered, or the service installed from within DAT-MAIL on a 
workstation (i.e. server with workstation(s) environment)). 

ACTIVATING & REGISTERING AWAM 

To activate and then register AWAM, perform the following: 
 

1. Launch DAT-MAIL on the server (or computer in a stand-alone environment).  From DAT-
MAIL’s main screen, select (click) the ‘File’ > ‘Program Settings’ > ‘Program Setup’; 
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2. DAT-MAIL’s Setup screen will display.  On the Import Defaults tab (default), enable AWAM 
by selecting (checking) the corresponding ‘Use AWAM’ check-box, and enter the server 
name (or computer name in the case of a stand-alone or single-installation environment); 

 
 

3. Click the OK button to close the Setup screen; 

4. Close and re-launch DAT-MAIL; 

5. On DAT-MAIL’s main screen, note that the Daemon icon (clock) has been replaced with the 
AWAM icon.  Click the AWAM icon; 
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6. The AWAM Control Center screen will display.  Select (click) ‘Help’ > ‘Registration’ > ‘New 
Registration; 

 
7. An UNREGISTERED PRODUCT dialog will display.  Click the OK button to resolve or close the 

dialog; 

 
 

8. The Registration Wizard for: AWAM dialog will display.  Click the Next button to continue; 

 
 

9. The Registration Wizard for: AWAM dialog will update with two options for registering 
AWAM.  Since this Guide assumes the registration key has already been obtained from 
Window Book, select (click) the 2nd option’s radio button (i.e. ‘Registration Key obtained.  
Enter it.’).   

 If the necessary registration key has not yet been obtained, follow the instructions on the screen 
for the first option, i.e. ‘Print Registration Request Form, to be faxed to Window Book’. 

 
 

Click the Next button to continue; 
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10. The Registration Wizard for: AWAM dialog will update.  Enter the registration key obtained 
from Window Book in the field provided; 

 
 

Click the Next button to continue; 
 
11. The Registration Wizard for: AWAM dialog will update, displaying the new registration key.  

Click the Save Registration Key button;    

 
 

After the Save Registration Key button is clicked, a Finish button will display on the 
Registration Wizard for: AWAM dialog.  Click the Finish button to close the dialog; 
 

12. The NEW REGISTRATION ACCEPTED dialog will display.  Click the OK button to resolve the 
dialog and close the AWAM Control Center.   

 
 

 Before AWAM can be launched, DAT-MAIL must be re-started! 
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13. Close the DAT-MAIL software and then open/launch it;     

14. From DAT-MAIL’s main screen, click the AWAM icon to launch AWAM; 

 
 

15. The AWAM Control Center screen will display.  Note that the status message next to the 
START button reads “Service is NOT installed”.  Proceed to the Installing the Service section 
in this Guide for more information on how to install the AWAM Windows® service. 

 
 

INSTALLING THE SERVICE 

Before AWAM can be used, AWAM’s Windows® service must be installed.  As part of the installation, 
valid log on credentials must be entered that will be used to run the service.  This procedure only needs 
to be done once, unless for whatever reason, the service gets uninstalled/removed or the log on 
credentials become invalid.  The service can only be installed from within the server instance of AWAM 
(i.e. not from a workstation instance). 
 

 Window Book recommends creating log on credentials specific for using AWAM to avoid any 
downtime due to things like a password change that isn’t carried over to AWAM, and/or users 
leaving the company. 
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Installing and removing the AWAM service is as easy as clicking the appropriate button in the DAT-MAIL 
AWAM Setup screen.  To access this screen, click the ‘File’ menu option within the AWAM Control 
Center and select ‘Setup’.   
 

 In a workstation instance of AWAM, the ‘Setup’ menu will not be displayed. 

 
 
The button that controls the installation is located on the left and the button that controls the removal 
is located on the right.  Whether the service is installed or not, is denoted by the corresponding button 
label; as well as, the text displaying red in color.   
 
 
 
If the service is not installed, the right button label will read 
“Service is removed” and the text will be red in color.  At the same 
time, the adjacent button label will read “Install Service” and the 
text will be black in color. 
 
 
 
 
 
 

Service Not Installed 
 
 
 
 
If the service is installed, the button label for installing the service 
will read as “Service is installed” and the text will be red in color.  
At the same time, the adjacent button label for removing the 
service will read “Remove Service” and the text will be black in 
color. 
 
 
 
 

Service Is Installed 
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To install the AWAM service, perform the following: 
 

1. Click the Install Service button; 

 
 

2. A Warning dialog will display informing the user that the service user must be in the 
Administrator group and asking for a confirmation of yes or no.  Click Yes to continue; 

 
 

3. The DAT-MAIL AWAM Log On Info screen will display.  The logon credentials used to run the 
AWAM service on the computer or server require the same Windows® rights, SQL 
roles/permissions, and folder/file permissions that a DAT-MAIL user needs if they are 
importing Mail.dat files.  They can be for the local machine (workgroup) or can be created as 
a domain login.  The log on credentials must also be part of an Administrator group or have 
Administrator rights. 

 Window Book does not recommend using a Local System Account for running AWAM. 

 
 

The requirements for the ‘Service Log On’ credentials are as follows: 
 

 Domain:  If the ‘User Account’ being entered is a “domain login”, enter the 
domain name it is associated with.   
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If the ‘User Account’ being entered is not a “domain login”, enter a period (‘.’) in the 
‘Domain’ field.  Entering a period causes the system to automatically default to the local 
computer name (the local computer name will not display in the field).   

 User Account:  The User Account is the logon or login name. 

 Password:  The password is encrypted.  Take care to avoid making any typing 
mistakes when entering the password. 

 
 

Select (check) the ‘Auto-start AWAM Service on System Boot Up’ if having the service 
start automatically is preferred. 

 
Click the OK button when finished to save the information entered (clicking the Cancel 
button will close the DAT-MAIL AWAM Log On Info screen without retaining/saving the 
entered logon information).   

 

 If an error message displays after the ‘OK’ button is clicked, refer to the INSTALL SERVICE & START 
SERVICE TROUBLESHOOTING section in this Guide. 

 
4. The DAT-MAIL AWAM Setup screen will display and show the service installed.  Click the OK 

button to close the DAT-MAIL AWAM Setup screen. 
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Install & Start Service Troubleshooting 

The following are possible errors that could result after the service log on credentials are entered and 
the OK button is clicked and/or when attempting to start the service: 

• Error 1057:  The most common causes for this error are:  Incorrect domain name; invalid or 
incorrect user name or password; or the username does not belong to the Administrator group.  
In addition, if the “Domain” field is left blank, this error message will also display. 

• Error 1058:  The most common cause for this error is that the service has been disabled.  Check 
the status using the Windows Service Manager for the service named “Window Book DM Import 
Daemon Service.”  Access the Windows Service Manager on the server (or computer in a stand-
alone environment) by clicking the Start button and selecting Control Panel > Administrative 
Tools > Services. 

 
 

• Error 1069:  The most common causes for this error are:  An incorrect password for the service 
log on account; or the user or log on ID does not have the necessary right of “Log on as a 
service.”  To confirm whether or not a user has a right of “Log on as a service”, click the ‘Start’ 
key on the server (or computer in a stand-alone environment), and select Control Panel > 
Adminsitrative Tools > Local Security Policy.   

When the Local Security Policy screen displays, expand ‘Local Policies’ and select ‘User Rights 
Assignment’.  Scroll down the list of Policies and right-click on “Log on as a service”.  Select the 
‘Properties’ menu option. 
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The Logon as a service Properties window will 
display.  Confirm the user is listed.  If it is not, 
click the Add User or Group button. 
 

 
 
 
 
 
 

 
The Select Users, Computers, Service Accounts, or Groups window will display.  Type the user 
name into the window and click the Check Names button.  In the example being used here, the 
user “vmuser” was entered. 
 

 
 
If multiple users are found, the user will be prompted to select the correct user from the list.  
Once the user is confirmed it will display in the Select Users, Computers, Service Acounts, or 
Groups window and be underlined. 
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Click the OK button to select the user, close the window, and display the Logon as a service 
Properties window.  Click the Apply button and then the OK button. 
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Changing the Log On Credentials 

 Changing the log on credentials for the AWAM service can only be performed on the server (i.e. 
not from a workstation). 

There are two options for changing the existing log on credentials that AWAM uses to run the service: 1) 
Changing them directly through AWAM; or 2) Using the Windows® Services Manager. 
 
THROUGH AWAM 
If at any point the logon credentials require changing, they can be changed directly from within the 
server instance of AWAM (i.e. not a workstation instance). 
 

1. From the AWAM Control Center screen, select ‘File’ and ‘Setup’; 

 
 
 
 
 

2. The DAT-MAIL AWAM Setup screen will display.  
Remove the service by clicking the Remove Service 
button; 

 
 
 
 
 
 
 
 
 
 

3. Then, reinstall the service by clicking the Install 
Service button; 
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4. The DAT-MAIL AWAM Log On Info screen will display.  Enter the ‘Service Log On’ credentials 
as directed in the Installing the Service section in this Guide, beginning with step 3. 

 Window Book does not recommend using a Local System Account for running AWAM. 

 
 
THROUGH THE WINDOWS® SERVICES MANAGER 
A second option for changing the logon credentials would be to do so from within the Windows® 
Services Manager, which is located on the server (or computer in a stand-alone environment) that 
AWAM is installed on.   
 

 IMPORTANT:  If changing the log on credentials using the Windows® Services Manager, make 
sure to stop the service in AWAM and close (not minimize) AWAM before doing so. 

1. Click the Start button on the server (or computer in a stand-alone environment) and select 
‘Control Panel’; 

2. From within the Control Panel, select ‘Administrative Tools’; 

3. From within the Administrative Tools screen, double-click on ‘Services’ which will be located 
in the list on the right to launch it; 

4. From within the Services screen, locate the “Window Book DM Daemon Import Service” and 
right click on it.  Select ‘Properties; 

 
 
 
 
 

5. Click/select the ‘Log On’ tab and make the 
necessary changes to the log on credentials.  
Click the Apply button, then the OK button when 
finished. 
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 Window Book does not recommend using a Local System Account for running AWAM. 

6. Within the AWAM Control Center screen, click the Start button to confirm the service starts. 

 
 

 When the service is running, it can be viewed in the Task Manager > Services tab.  See the screen 
images below.  Note that the ‘Startup Type’ for the service is displayed as “Manual”.  If the ‘Auto-
start AWAM Service on System Boot Up’ option located in the ‘DAT-MAIL AWAM Log On Info 
screen had been enabled (checked), the value displayed would be “Automatic”. 
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PERFORMANCE-RELATED SETTINGS 

There are settings that should be addressed before using AWAM 
as they have the potential to impact performance (the default 
settings can be used, or they can be adjusted to best fit a Client's 
individual operations).  These settings are located in the three tabs 
that make up the DAT-MAIL AWAM Setup screen (i.e. General; 
Maintenance; and Notifications).  The DAT-MAIL AWAM Setup 
screen is accessible from within AWAM’s ‘File’ > ‘Setup’ menu 
option, which is only available within a server instance of AWAM 
(i.e. not from within a workstation instance of AWAM). 
 

 

General Tab 

• Max. Agent Processes:  The maximum number of profiles that can run simultaneously (default = 
1); 

 In a server with workstation(s) environment, Window Book recommends beginning with a "Max 
Agent Processes" of 6, and in a stand-alone or single-installation environment, a "Max Agent 
Processes" of 2. 

 The maximum number of profiles that can run simultaneously is 20; however, this number can be 
affected by the amount of available memory on the server and the size of the Mail.dat files being 
imported. 

• Wait Interval (seconds):  How often the AWAM service checks the appropriate import folder(s) 
for incoming Mail.dat files (default = 3 seconds);  

• Communication Port:  The port AWAM will use for communicating over the Web.  The default 
(3000) can be changed by the Client if there is a conflict such as another application using the 
same port or port 3000 is out of their allowable range; 

• Allow to use multi-instance AWAM CC: Allows multiple users to run the AWAM Control Center 
(CC), simultaneously through the use of a special IP address (see ‘Multicast Group IP Address’ 
below); and 

• Multicast Group IP Address:  This field becomes enabled or active when the ‘Allow to use multi-
instance AWAM CC’ option is selected (i.e. checked).  This is a special IP address type that is 
required in order to be able to have multiple users run the AWAM CC simultaneously.  Use the 
default address provided.  If it is determined that the default will or  does not work with their 
system, Clients will have to contact their IT department to obtain a Multicast IP Address that 
works with their system.   
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Maintenance Tab 

 
 
‘CMD’ files are generated every time an AWAM process is run.  They are stored in the 
\\...\wb\MDV\data\AWAMCMDFiles folder on the server (or computer in a single-installation or 
standalone environment); specifically, in one of three folders (i.e. Input, Processed, or Failed).   
 

 
 
When they are initially created, CMD files are located in the Input folder; however, after processing 
completes, they are moved by the service into the Processed folder or the Failed folder.  The status of 
the process determines which of those two folders they are moved to.   
 
Over time, the number of CMD files that are on the server in the Processed and Failed folders can 
impact disk space an eventually, system performance.  Therefore, it is important to delete or purge 
these files on a regular basis.  AWAM purges the CMD files in the Processed and Failed folders daily and 
any time the AWAM service is started.  They are purged based on the cut-off date that is set in the 
Maintenance tab.  The Auto-delete will purge the CMD files older than the date specified.  In the image 
above, the Auto-delete process will purge CMD files older than 10 days (default). 
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All the existing CMD files that are located in the Processed and Failed folders can be purged by the user, 
including files newer than the date specified (e.g. 10 days) by clicking the Delete Processed CMD Files 
button.  
 

 
 
To also help maintain disk space and system performance, users can also set up AWAM to automatically 
delete the Log Records created during processing that are older than a specified number of days (default 
is 7 days). 

Notifications Tab 

AWAM can be set up to send e-mail notifications to Client-
specified users when a file has been processed successfully and/or 
when a file’s processing fails.  In addition, the ‘Notify on Server 
Failure’ option exists to be able to notify recipients when 
something happens with the service (not ‘server’) that is not 
related to Mail.dat file processing, such as when the connection to 
MS SQL is lost.  
 
Simply select (check) the box of the notification type(s) that should 
be enabled and enter the correct e-mail address of the recipient.  
Multiple e-mail addresses can be entered for each notification by 
separating the e-mail addresses with a semi-colon (;).  To test that 
communication exists between AWAM and the recipients of each 
enabled notification, click the corresponding TEST button to send a test notification. 
 

 Depending upon the number of AWAM processes that are run each day, the number of e-mails 
received if ‘Notify on Success’ is enabled could be overwhelming for the recipient(s). 

 To ensure delivery of system-generated notifications, it is important for Clients to white-list the 
pertinent Window Book send-from e-mail addresses on their server(s).  A list of these e-mail 
addresses can be found on the Window Book web site at:  
https://www.windowbook.com/home/White-List-Help. 

https://www.windowbook.com/home/White-List-Help
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The subject line of the Successful e-mail will provide the Job ID, Job No., the Status of the AWAM 
process, and the name of the server the process was run on.   
 
The subject line of the Successful e-mail will provide the Job ID, Job No., the Status of the AWAM 
process, and the name of the server the process was run on.   
 
The body of the e-mails will provide what type of process was run (i.e. import, merge, post-import), 
what profile was used for the process, a date/time stamp, the Job ID (in the event of a merge, the job ID 
of the newly created Mail.dat is provided), the Job No., the Job Description (i.e. Job Name), and the 
name of the Mail.dat file name that was imported. 
 

 
 
The Failed e-mail notification will provide a status notification in the Subject line along with the file 
name.  The e-mail will also contain information about the error(s) that caused it to abort and where the 
associated file is located on the server (or computer in a single-installation or stand-alone environment). 
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Example E-Mail Notification of Service Failure 
 

 
 
 

ACTIVATING AWAM ON WORKSTATIONS 

DAT-MAIL should be installed and registered/setup on the server, followed by the activation, 
registration and setup of AWAM, before DAT-MAIL is installed on the workstation(s).  Once the server 
piece is complete, AWAM will automatically be carried over to the workstation(s) with the installation of 
DAT-MAIL. 
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DAT-MAIL ‘SECURITY’ USERS 

 
 
For Clients who use DAT-MAIL/AWAM with the ‘Security’ feature enabled, a Login ID and Password is 
required in order to successfully export files to PostalOne! using AWAM.  Within DAT-MAIL, enter the 
Login ID and Password in the File > Program Settings > Program Setup > Setup > Import Defaults tab > 
Daemon Auto.. tab. 
 

 
 
The Login ID and Password should be the same credentials that the Client has specified in Security for 
the account being used to run the AWAM service (NOT the AWAM service credentials).  After entering 
the credentials, click the OK button, close AWAM (if open), and re-launch DAT-MAIL. 
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UPDATING THE SOFTWARE 

Updates to AWAM occur when the DAT-MAIL software is updated.  Before attempting to install an 
update to the DAT-MAIL software on the server (or computer in a stand-alone or single installation 
environment), confirm the following:   

• DAT-MAIL is not running on the server or any workstation(s); 

• The AWAM service is not running; 

• The Control Center should not be open/minimized; 

• The Automation Scheduler’s service should not be running; and 

• The AWAM File Manager application should be closed. 

 

 This applies to the server (or computer operating in a stand-alone environment) only.  The auto-
update of the DAT-MAIL software installed on workstations is not affected if the AWAM service is 
running. 

If an attempt is made to update the DAT-MAIL software on a computer or server with the AWAM service 
running, the following dialog will display when the InstallAware wizard begins the update process: 
 

 
 
Click the OK button to resolve the dialog.  Right click on the AWAM icon located in the computer or 
server’s System tray and select the ‘Stop Service and Exit’ command.  Begin the install again. 
 

 If imports are being processed, the appropriate executable file (MdImpDaemon707.exe) will 
continue to run even after the service and Control Center are shut down, until the import process 
is complete.  Therefore, it may be necessary to wait for any import processes to complete before 
attempting a STOP and/or shut down.  How long an import process takes to complete is 
dependent upon the size of the Mail.dat file being imported. 
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 For troubleshooting needs it is important to be aware that the service can be running even if the 
AWAM Control Center is not displayed and/or there is no AWAM icon displayed in the computer 
or server’s System tray.  Access the Task Manager on the computer or server to determine 
whether the service or any of the AWAM-related executables are running that should not be 
when attempting to install an update to the DAT-MAIL software on the computer or server.  A list 
of those executables is provided here: 

▪ Mdb707.exe:  The main DAT-MAIL executable 

▪ MdImpCC707.exe:  The AWAM Control Center executable 

▪ MdImpServer707.exe:  The AWAM service executable (this is what monitors the input folders for files 
to import) 

▪ MdImpDaemon707.exe:  The AWAM import executable (performs the actual import of the Mail.dat 
files into DAT-MAIL) 

 
 

 If referring to the Task Manager, make sure to enable the SHOW PROCESSES FROM ALL USERS 
function to make sure the AWAM service’s processes display, since they will likely be running 
under a login different than what was used to log into that computer or server.  Depending upon 
which operating system the computer or server is using, this feature is enabled by either checking 
a box or clicking a button. 

If a shutdown is required and the service is running, and there is no AWAM icon displayed in the 
computer or server’s System tray, launch DAT-MAIL, access the AWAM Control Center, and click the 
Stop button. 
 

 If imports are being processed, the appropriate executable file (MdImpDaemon707.exe) will 
continue to run even after the service and Control Center are shut down, until the import process 
is complete.  Therefore, it may be necessary to wait for any import processes to complete before 
attempting a STOP and/or shut down.  How long an import process takes to complete is 
dependent upon the size of the Mail.dat file being imported. 
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 Do NOT use the Task Manager on the computer or server to stop the AWAM service! 

UPDATING WORKSTATIONS 

Software updates to DAT-MAIL should be carried out on the server first, along with any setup changes to 
AWAM.  Once that is complete, then workstation installations of DAT-MAIL should be updated.  Any 
updates or changes that were made to AWAM on the server will automatically carry over to the 
workstation(s). 
 


